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EndNote Desktop

EndNote application that is installed on to your
computer.

Works on Mac and Windows.

You can install on up to three different machines.

Ensure that you download the software from IT
Services - https://help.it.ox.ac.uk/how-to-get-software



https://help.it.ox.ac.uk/how-to-get-software

Setting up EndNote Web

EndNote Web gives free access to references when away from
personal computer.
Syncs with your desktop version of EndNote.

You need to be using EndNote 21 to use EndNote Web.

Register at: https://web.endnote.com/login

Do not recommend using EndNote Web on its own.


https://web.endnote.com/login

Adding references




Options for adding references

Online search within EndNote
Export references from databases
EndNote Click

Drag and Drop PDFs into EndNote
Enter references manually

EndNote Capture Reference browser plugin



Online Search (1)

® EndMNote 20

helen.bond@beodleian.ox... Online Search
@ Sync Status

Retrieve results: 25 50 100 500 5000

[E All References ° 2
£ Recently Added
B Unfiled

Author Year Title

T Trash

2> MY GROUPS

“ FIND FULL TEXT

» GROUPS SHARED BY...

Click the database title you
R would like to search or click
@ Jisc Library Hub... ‘ ,
® Library of Congre... more..." to select a database

@ LISTA (EBSCO) not listed.
@ PubMed (NLM)

@ Web of Science C...

more...




Online Search (2)

helen.bond@bodleian.ox... All Fields @ Caontains © obesity +=| | =
@ sync status And All Fields 2 Contains £ | child® + -
[E All References . W T
o X Clear Search Search Options ﬂ ‘“ﬁ- m-
fa Recently Added -
B Unfiled ' PubMed (NLM)
Tl Trash
o LV elielL [ @ Author Year Title Journal Last Updated Ref T
1, ype

w FIND FULL TEXT
“w GROUPS SHARED BY...
“ ONLIMNE SEARCH .

® Jisc Library Hub.. Enter your search terms in the

@ Library of Congre...

g search boxes at the top of the

. ‘ y
screen and click ‘Search’.




Online Search (3)

You can increase the
number of records on
the page at the top of
the results list.

helen.bond@bodleian.ox... AllFields T Contains + (=
Sync Status And 2 All Fields & Contains child® +| -
[E All References , o R e —
X Clear Search Search Options “ m
£\ Recently Added
B Unfiled i Searching PubMed (NLM)
=
R Retrieve results:
> MY GROUPS -
[ ) @ Author Year Title Journal Last Updated  Ref Type
v FIND FULL TEXT ) . . L . . .
) Stern, M.; Gray,... 2021 A cluster-randomized control trial targeting parents of pediatri.. Contemp Clin Trials 01/02/2021 Journal Article
v GROUPS SHARED BY...
[ ) De Leon-Ramire... 2021 Histomorphological testicular changes and decrease in the sp...  Ann Anat 01/02/2021 Journal Article
“ ONLINE SEARCH
@ uJisc Library Hub... ® Lokken, E. M.; H... 2021 Disease Severity, Pregnancy Qutcomes and Maternal Deaths a.. Am J Obstet Gynecol 01/02/2021 Journal Article
@ Library of Congre...
@® LISTA (EBSCO) ) Assfalg, R.; Kno... 2021 Oral insulin immunotherapy in children at risk for type 1 diabet...  Diabetologia 01/02/2021 Journal Article
@ PubMed (NLM) 500 _ _ o _ ) )
i ) ® McCarthy, E. K.;... 2021 Behavioral consequences at 5 y of neonatal iron deficiency in... Am J Clin Nutr 01/02/2021 Journal Article
@ Web of Science C...
more... ) Reyes, 5. M.; Mil... 2021 Messaging and methodological considerations when researchi...  Eur J Clin Nutr 01/02/2021 Journal Article




Online Search (4)

Double clicking a
reference brings up a
summary of the
reference in a pane on
the right

o EndNote 20 - My EndNote Library.enl

All Fields 2 Contains 2 | obesity 4+ =

helen.bond@bodleian.ox...

s Sync Status Contains < | child* +| (=

Search Options E w

And 2 All Fields 2

IE All References % Clear Search

L Recently Added
El unfiled
Tiil Trash

Searching PubMed (NLM)

Retrieve results:

@

> MY GROUPS

[} @ Author ~ Year  Title Jour
“ FIND FULL TEXT
® Pyle, A.K.; Cant... 2021 Antibiotic exposure and growth patterns in preterm, very low b... Mat
“ GROUPS SHARED BY...
[ ] Hashemian, S. R... 2021 Mesenchymal stem cells derived from perinatal tissues for trea... Ster
“ ONLINE SEARCH
@ uisc Library Hub i < Eri ; — ity in Sy e mai i
— Y ® Eiholzer, U.; Frit.. 2021 The increase in child obesity in Switzerland is mainly due to mi... BMC
@ Library of Congre...
@ LISTA (EBSCO) ® Reeve, E.; Thow,... 2021 Identifying opportunities to strengthen school food environme...  BMC
@ PubMed (NLM) 500
[ ] Tung, J. Y.; Ho, F... 2021 Does obesity persist from childhood to adolescence? A 4-year... BMC(

@ web of Science C...

more...

Beckman, M.; H... Understanding Individual and Socio-cultural Factors Associate...

Zheng, H.; Xu, Z... Long-term exposure to ambient air pollution and obesity in sc...

De Groot, C. J.;...

Clinical management of patients with genetic obesity during C...

] Zheng, 2021 #13
B I U X X

Reference Type

Author

Year

Title

Journal
Volume

Part/Supplement

Summary m b 4

Q,

Journal Article [ ]
Zheng, H.
Xu, Z.
Wang, Q.
Ding, Z.
Zhou, L.
xu, Y.

Su, H.

Li, X.
Zhang, F.
Cheng, J.

2021

Long-term exposure to
ambient air pollution and
obesity in school-aged children
and adolescents in Jiangsu
province of China

Environ Res

10



Online Search (5)

Highlight references you would like to add to
your library and click the plus button. They
will be added to the ‘recently added’ area.

& EndNote20 File Edit References Groups Library Tools Window Help x) A I = 100%E Mon1Feb 16:22 Helen QA =

=13

[E All References

¥ Clear Search Search Options n m
L Recently Added

Retrieve results: 66,221

[ unfiled ; Searching PubMed (NLM)
T Trash @

> MY GROUPS
v [ ] & Author ~ Year Title Journal Last Updated  Ref Type

% FIND FULL TEXT
Pyle, A. K.; Cant... Antibiotic exposure and growth patterns in preterm, very low b... Matern Health Neonatol Perin...  01/02/2021 Journal Article

“ GROUPS SHARED BY...
Hashemian, S. R... Mesenchymal stem cells derived from perinatal tissues for trea... Stem Cell Res Ther 01/02/2021 Journal Article
% ONLINE SEARCH
@ Jisc Library Hub Eiholzer, U.; Frit... The increase in child obesity in Switzerland is mainly due to mi.. BMC Public Health 01/02/2021 Journal Article
@ Library of Congre...
@ LISTA (EBSCO) [ ] Reeve, E.; Thow,... 2021 Identifying opportunities to strengthen school food environme... BMC Public Health 01/02/2021 Journal Article

@ PubMed (NLM) 500

. ) Does obesity persist from childhood to adolescence? A 4-year... BMC Pediatr 01/02/2021 Journal Article
& Web of Science C...

Tung, J. Y.; Ho, F...

more... Beckman, M.; H... Understanding Individual and Socio-cultural Factors Associate... Appetite 01/02/2021 Journal Article

Zheng, H.; Xu, Z... Long-term exposure to ambient air pollution and obesity in sc...  Environ Res 01/02/2021 Journal Article

De Groot, C. J.;... 2021 Clinical management of patients with genetic obesity during C...  Endocrine 01/02/2021 Journal Article
Mohamed, R. N.;... 2021 Association Between Dental Caries and Obesity among Childre... Oral Health Prev Dent 01/02f2021 Journal Article
Coleman, C. M.;... 2021 Influence of a One-Time Web-Based Provider Intervention on...  J Patient Cent Res Rev 01/02/2021 Journal Article

Kansra, A. R.; La... 2020 Childhood and Adolescent Obesity: A Review Front Pediatr 01/02/2021 Journal Article

14
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Exporting records from
SOLO




Exporting items from SOLO

1. Login to SOLO using your Single Sign On

2. Search SOLO and mark some results by
clicking the # pin next to the item. They will

save to ‘Favourites’

NEW SEARCH BROWSE MAPSEARCH FEEDBACK HELP TAGS

oooooooooo
LLLLLLLLLLLLLLL

acquisitions go global

B 72 Result: S
Sort & Filter Results suits Y Save quary

~ N P R ~ 1 NEWSPAPER ARTICLE
Include results without full “text access Japan's Car-Parts Makers Go Global ; Spurt of Acquisitions Aims To
Widen Suppliers’ Reach; Following Toyota Overseas
Sort by Morse, Andrew
Wall
Sho l\_,' . nnnnnnnnnnnn
Open A 2 BOOK B8 2
pen cfess _ o » Acquisitions go global : an introduction to library collection

management in the 21st century
Agee, J. (Jim)

T, Ageel(im)
-'-’f 44 1007 | Oxford : Chandos | xvii, 132
Library v Find & Request

3. Access your Favourites for a list all of the
records you have marked




Exporting items from SOLO (1)

4. Select the items you want to export.

1 Favourites 7 X

& & 5 B 0 ~ v
EXCEL PRINT E-MAIL BIBTEX ENDNOTE MENDELEY REFWORKS 9

CLOSE 3

ARTICLE Lg) B \1\
Acquisitions Go Global: An Introduction to Library Collection Management in the

21st Century20072Jim Agee. Acquisitions Go Global: An Introduction to Library
Collection Management in the 21st Century. Oxford: Chandos Publishing 2007.
xvii + 132 pp., ISBN: ISBN 978-1-84334 327-1, 978-1-84334-326-4 paperback,
hardback, £39.95, £57.00

lames, Stuart

Library review (Glasgow), 2007-10-16, Vol.56 (9), p.829-830

|_
<
T
o
L
=
—l
I §

@ Online access

[ Download PDF (4 H Read Article ZH View Issue Contents (4

BOOK
Acquisitions go global : an introduction to library collection management in the
21st century [electronic resource]

. Agee, James L
N e

5. Click the “Push to’ actions” three-dot icon
and you can either select RIS or EndNote.

D
2



Exporting items from SOLO (2)

Choosing ‘RIS’ exports the record to the desktop
version of EndNote so is good to use when on
your machine which has EndNote installed.

Choosing ‘EndNote’ exports the record to
=1/\[e}{=1] EndNote Online, which is a good option when
you are away from your computer.

15



Exporting items from SOLO (3)

6. Alternatively, to export a single record, click the three-dot
export button.

BOOK {p"} E *’
The Oxford history of Britain

Morgan, Kenneth O
1993 | Updated ed | Oxford : Oxford University Press | xii, 747 p.: maps, geneal.tables ; 20 cm

Find & Request

EEEEEEEEEEEEE

16



Exporting items from SOLO (4)

8. If you opt for the
@:._ RIS option, your
browser will
download the RIS

Always open files of this type

Show in folder

™| delivery.ris

9. The RIS file will file. Click on the file

automatically be to open it.
Imported into your

EndNote library under

‘Imported References'.

File Edit References Groups Library Tools Window Help

2 Sync Configy -ation

E All Referer < » 1
® Imported References 1

Q Recently Added L Imported References
B Unfiled 1 1 Reference
W Trash 0

Author Year Title Rating Journa | Last.. Refere..

v MY GROUPS

Morga... 1993 The Oxford history of Britain 09/0... Book



Adding references from
Google scholar




Exporting items from Google Scholar (1)

1. From the Google = Google Scholar
Scholar search page, R
click the menu button * iy ibrary
then Settings S Aerts
2. Scroll down to e
Bibliography manager o pavancesseare
settings of settigs |
3. Select to “Show links to import
citations into” — choose EndNote from 4. Save preferences

the dropdown menu

/ 4
Bibliography manager
Don't show any citation import links.

@ Show links to import citations info EndNote 5 -

19




Exporting items from Google Scholar (2)

4. Search results should now offer the option to
Import to EndNote.

Deaths in the family: The loss of a son
RF Whesler - Shakespeare Quarterly, 2000 - JSTOR

... DEATHS IM THE FAMILY 133 ... are juxtaposed by Shakesp 24 For Wilson "it is only by
attanding to his matarial discursivity that Shakespearean language ¢ .. and restored to its
true scenario, which is the author's society:"23 Much of what Shakespearefhioariabe boza

7 UY Cited by 27 Related articles  All 3 versions  Web of Science: §  Import into EndMote

the rise of Shakespearean comedy

5. An ENW file Is created. It may open automatically
otherwise open the file manually from your browser
or files. The references will be imported into your
desktop EndNote library under ‘Imported
References'.



Exporting items from Google Scholar (3)

6. Alternatively you can select multiple records by
clicking the star.

Deaths in the family:
RP Whesler - Shakes e Quarterly, 2000 - J5TOR

... DEATHS IN AMILY 133 ... are juxtaposed by Shakespeare:"21 For Wilson "it is only by
attending to hi terial discursivity that Shakespearean language can be ... and restored to its

0= Ycenario, which is the author's society:"23 Much of what Shakespeare's biography brings ...
ﬁ Y Cited by 27 Related articlas  All 3 versions  Web of Science: 6 Import into EndNote

This saves the titles to ‘My library’, where you can
export multiple references at once to EndNote.

e loss of a son and the rise of Shakespearean comedy




Exporting items from Google Scholar (4)

/. This saves the titles to ‘My library’, where you can
export multiple references at once to EndNote.

= Google Scholar

My library

All articles
Reading list
Trash

Manage labels...

Any time

Since 2022
Since 2021
Since 2018

Custom range...

¥ Export all

BibTeX

RefMan
CSv

Search my library

® My profile

ticles in your library
- chicken pox vaccine

1s compulsory vaccination: the ltalian experience
:cia, R Siliquini - The European Journal of ..., 2018 - academic.oup.com

[HTML] oup.com
Find it @ Oxford

Vaccine hesitancy is a phenomenon that has increased widely in the last few years, in the

Europe and in the USA, giving its consequences on vaccine coverage rates. The decrease ..

99 Cite © Label T[J Delete ¢ Edit Cited by 17 Related articles All 11 versions Web of Science: 11
Import into EndNote  4&

Improved temporal trends of vaccination coverage rates in childhood after the
mandatory vaccination act, Italy 2014-2019
M Sabbatucci, A Odone, C Signorelli, A Siddu..

[PDF] mdpi.com

Find it @ Oxford

- Journal of Clinical ..., 2021 - mdpi.com

Maintaining high vaccine coverage (VC) for pediatric vaccinations is crucial to ensure herd
immunity, reducing the risk of vaccine-preventable diseases (VPD). The ltalian vaccination ...

99 Cite © Label T7J Delete o

o

w My library

22



Have a go!

www.bodleian.ox.ac.uk/ask/workshops/reference-management-
workshop-handouts

* Online search
« SOLO
» Google Scholar
» Databases:
* Humanities

» Medical Sciences and MPLS (Mathematical, Physical and Life
Sciences)

« Social Sciences
» English literature, modern languages and literature, linguistics



https://www.bodleian.ox.ac.uk/ask/workshops/reference-management-workshop-handouts

Importing records when there is
no direct export option




Adding references by
drag & drop PDF



Adding references by drag & drop (1)

You can drag
and drop full text
articles and
other documents
that you have
saved to your
computer into
EndNote

/ EndNote Lib

= Documents

=1 M + | Documents — O b4
Home Share View G
<« v T [ » ThisPC > Documents > 9] £ Search Documents
&= Pictures ) Name Date modified Type

B My EndNote Library 02/12/2020 14:41 EndNote Libj

H drive EH Fustian and Velvet Cutting A Subdivision of the Lancashire Cotton Indust... 13/10/2020 16:16 Microsoft Ed
saved emails Zoom 26/05/2020 19 File folder
Screenshots Qutlook Files File folder
& OneDrive OneNote Notebooks File folder
My EndNaote Library.Data File folder
= This PC My EndNote Library Copy.Dala File folder
M 20 Nhiact Custom Office Temnplate 05/06/2020 12:56 File folder

File Edit References Groups Library Tools Window Help

Imported References

Drag & drop

helen.bond@bodleian.ox...

@ Sync Status

Advanced search

B All References 469

® Imported References 1
L Recently Added 15

Imported References
1 Reference

B Unfiled 409

W Trash 63

v MY GROUPS

Author Year

Holden... 2017

Fustian and velvet cuttin...

Rating Journal

Indust...

26



Adding references by drag & drop (2)

When you drag and drop a document,
EndNote will try to find matching
bibliographic information and add it to
your EndNote Library. Note:

* Does not work for all documents
(most likely to work for PDFs of
articles)

 Bibliographic data may include
errors. Check your data and make
changes as necessary.

E Janarthanan, 2017 #515 summary TR X

B /7 U X' X

Reference Type

Author

Year

Title

Journal

Volume

Part/Supplement

Issue

Pages

Start Page

Q
Journal Article [T

Janarthanan, M.
Senthil Kumar, M.

2017

The properties of bioactive substances
obtained from seaweeds and their
applications in textile industries

Journal of Industrial Textiles

48

1
361-401

361




EndNote Click



EndNote Click (1)

* Previously called Kopernio.

* Free browser plugin, which:
» speeds up the process of accessing full-text PDFs

« allows you to export those PDFs to EndNote and generates a
reference in EndNote.

« Not compatible with every database/platform.
* Requires account with EndNote Click.

« Google Chrome, Firefox and Opera.

« 100MB of free storage.



EndNote Click (2)

Adding plugin to your browser:

 Go to kopernio.com

« Depending on your browser, there will be a button that says
Add to Firefox for free or Add to Chrome for free, etc.

& Add to Chrome for free

30


https://kopernio.com/

EndNote Click (3)

Navigate to a database and enter your search.

Pu bt&]ed .gov

type 2 diabetes X Search

Advanced

Sl



EndNote Click (4)

In the results
page, the
EndNote Click
browser plugin
will highlight
PDFs that you
can directly link
to In order to
read. Click View
PDF.

Pancreatic beta-cells in type 1 and type 2 diabetes mellitus: different
pathways to failure.

Eizirik DL, Pasquali L, Cnop M.

Mat Rev Endocrinol. 2020 Jul;16(7):349-362. doi: 10.1038/s41574-020-0355-7. Epub 2020 May 12.
PMID: 32398822 Review.

Loss of functional beta-cell mass is the key mechanism leading to the two main forms of diabetes
mellitus - type 1 diabetes mellitus (T1DM) and type 2 diabetes mellitus (TZDM). ...Here, we
review these new findings, f ...

( View PDF )

Sodium-glucose cotransporter type 2 inhibitors for the treatment of type 2
diabetes mellitus.

Scheen AJ.

Mat Rev Endocrinol. 2020 Oct;16(10):556-577. doi: 10.1038/541574-020-0392-2. Epub 2020 Aug
27.

PMID: 32855502 Review.

The management of type 2 diabetes mellitus (T2DM) is becoming increasingly complex. Sodium-

glucose cotransporter type 2 inhibitors (SGLT2is) are the newest antidiabetic agents for T2DM. ...

\ Search library

32




EndNote Click (5)

The PDF will open in EndNote Click and automatically save it to
your ‘Locker’.

® My Locker ] 1} 2 4+ ¥ EYl (1 of 5) — 4+  AutomaticZoom B

5. Requeiro, C. Matte-Gagne, A.B...

.’:'_.:'n'-'ui-' Childhood Research ... (2['22:' Early Childhood Research Quarterly 58 (2022) 27-34

Contents lists available at ScienceDirect

[+ Saved in Locker

Early Childhood Research Quarterly

journal homapage: www.alseviercom/locate/acrasg

& Download PDF

¢ Share PDF Paternal mind-mindedness and child executive functioning in the

SR kindergarten classroom
Xportrererence

Sophie Regueiro ? Célia Matte-Gagné®, Annie Bernier®*
& Pushto EndNote Web

A University of Monireal, Department of Paychology, PO Box 6128 Downtown Station, Montreal H3C 3J7, Conoda
® Laval University, 2325 rue de ['Université, (uebec GV 0AS, Conada

B Visitjournal page

ARTICLE INFO ABSTRACT

To export the PDF to EndNote, click Export to EndNote.

58]



EndNote Click (6)

The PDF file will display in the ‘Imported References’ area of
your EndNote Library.

EndNote 20 - My EndNote Library.enl

[ ]

helen.bond@bodleian.ox... Q, Advanced Search
@ All References Imported References & @

I3

® Imported References

L Recently Added
El unfiled
Till Trash

Author Jour

Eizirik, Décio L.;... 2020 Pancreatic B-cells in type 1 and type 2 diabetes mellitus: differ... MNat

2 MY GROUPS
v FIND FULL TEXT

v GROUPS SHARED BY...

v ONLINE SEARCH

El Eizirik, 2020 #562

B I/ U X X

Reference Type

Author

Year

Title

Journal

Summary iy b4
Q,
Journal Article a
Eizirik, Décio L.
Pasquali, Lorenzo
Cnop, Miriam
2020

Pancreatic B-cells in type 1
and type 2 diabetes mellitus:
different pathways to failure

Mature Reviews Endocrinology

34



Adding reference
manually



Adding reference manually (1)

1. Click on the plus button in the toolbar:

A

&

New Reference (My EndNote Library)

File Edit References

Groups Library Tools Window Help

B Edit PDF

B I U X' Xi Q
Reference Type [J al Articl

Autho

Yea

Titl

Journal

Volume

2. Choose a
material type
from the drop
down menu



Adding reference manually (2)

3. Choose a material type from the drop
down menu (e.g. journal article, book,
thesis, web page etc.)

Note - There are several different types of
‘Book’

* “Book” = standard book by one or more
authors

* “Book, Section” = Chapter

 “Edited Book” = edited collection of
chapters/essays by multiple authors

Aggregated Database
Ancient Text

Artwork

Audiovisual Material
Bill

Blog

Book

Book Section

Case

Catalog

Chart or Table
Classical Work
Computer Program
Conference Paper
Conference Proceedings
Dataset

Dictionary

Discussion Forum
Edited Book
Electronic Article
Electronic Book
Electronic Book Section

S




Adding reference manually (3)

New Reference (My EndNote Library) - O

File Edit References Groups Library Tools Window Help

B Edit PDF

5. Fill in the form. Try to fill in
as many fields as you can! e .

Reference Type | Newspaper Article v

Reporter

Year

6. Use the keyboard shortcut to .
save the reference, or close the
window, which will prompt you
to save.

Volume

Frequency




Capture EndNote
Reference plug-in



Capture EndNote Reference

Captures metadata from website and
generates reference, e.g. news website, blog.

Installation information and instructions on
how to use in handout.

338
il



Have a go!

www.bodleian.ox.ac.uk/ask/workshops/reference-
management-workshop-handouts

» Drag and drop PDFs

« Manually adding a reference
« EndNote Click

* Browser plugin

41


https://www.bodleian.ox.ac.uk/ask/workshops/reference-management-workshop-handouts

Looking after your
references

Adding notes and documents, editing, de-duplicating references, groups




Attaching documents and adding notes

E Mirsky, 1997 #3 Summary QIS X
B 7 U X X Q

TO add pel’SOﬂa| nOteS Notes |nternational forum; 1st

INTERMATIONAL CONGRESS SERIES

CliCk in the Research -AMSTERDAM- EXCERPTA MEDICA THEN

ELSEVIER SCIENCE-

g VOL 1166
N Otes fleld . MNew York; Elsevier, 1998

1998
Papers

To attaCh a document, CI|Ck Research Notes

on attach file in the editing URL
pane and navigate to your File Attachments (SN
saved document or drag Author Address

and drop the file.



Editing references

Some records will need editing, especially from
SOLO

If you do not edit your records this may lead to
errors in your bibliographies and citations

44



Finding duplicate references (1)

Click Library > Find Duplicates

EndNote 20 File Edit References Groups im Tools Window Help
o o sync
Advanced Search #EF
All References
All References _Sort Library...

Imported References

(@ Anna Karenin...

(@) Assessing im...
(@ Beyond the cr...

10
13
31

CELEESISS  Find Duplicates )y, |

“FINd Broken Attachment Links E

@ @ Auth
Open Term Lists b

@ De” Define Term Lists... #4 wai
Link Term Lists... #3

o Del  spell Check Library... sgy MO
Find and Replace... #R

2 Goh  Change/Move/Copy Fields... f Ex

° Hekb Recover Library... atia
Library Summary

@ Huana. C.C.: Yu... 1996 Computer-Aide:

45



Finding duplicate references (2)

Decide which record to keep and click Keep This

Record

Keep this Record

Dubinin, 2018 #6507

Author

Dubinin, E.
Fraenz, M.
Patzold, M.
Halekas, J. S.
McFadden, J.
Connerney, J. E. P.
Jakosky, B. M.
Vaisberg, O.
Zelenyi, L.

Year
2018

Title

Journal

Volume
45

Comparing 1 and 2 of 2 duplicates.

Ref Type: Journal Article

Solar Wind Deflection by Mass Loading in the Martian Magnetosheath
Based on MAVEN Observations

Geophysical Research Letters

Added to Library: 02/12/2020 Last Updated: 02/12/2020

Select the record to keep. The record not selected will be moved to the Trash. Select Skip to go to the next set of duplicates.

Keep this Record

Dubinin, 2018 #512
Ref Type: Journal Article

Author

Dubinin, E.
Fraenz, M.
Patzold, M.
Halekas, J. S.
McFadden, J.
Connerney, J. E. P.
Jakosky, B. M.
Vaisberg, O.
Zelenyi, L.

Year
2018

Title

Skip Cancel

Solar Wind Deflection by Mass Loading in the Martian Magnetosheath

Based on MAVEN Observations

Journal
Geophysical Research Letters

Volume
45

Added to Library: 02/12/2020 Last Updated: 02/12/2020




Creating groups (1)

1. Click Groups > Create Group

File Edit References m Library Tools Window Help

" CreateGrowp |
Create Smart Group
Duplicate Create From Groups...

e & le

Bl lar Wind Deflectic
Add References To I

@ More Viscous-Liki
Create Group Set

ke isponse to White ¢

® Create Citation Report isponse to White ¢

@ Jackson, Gordon 1994 Great Britain and Ire

47



Creating Groups (2)

v MY GROUPS

2. Type the name for your

v Test

g r'ou p (@ Anna Karen...

(&) Assessing i...

(@ Beyond the...
(&) Cave art

(& Chocolate
(= DLT

(® Roald Dahl
(@ Shakespeare
(® Solar wind
(@) Trees

(@ Zhou test f...

(®|New Group _|




Moving references into groups (1)
Method 1.

Click Groups > Add References To.
Select the group you would like to move the references to.

EndNote 20 File Edit References m Library Tools Window Help

Create Group
Create Smart Group
Create From Groups...

@

All References 469
Duplicate References 62 A09 heleren

All Refere

Imported References 1 le
Recently Added 14

Unfiled
Trash Refences To

REMOve nel nces

o manual of water plants

Create Custom Group...

C -
From

Test
MY GROUPS Create Group Set Assessing impact of information skills teaching
o Test Delete Group Set Cave art
) » roup Set DLT
(& Anna Karenin... Roald Dahl ar
(@) Assessing im... s by e Shakespeare
(& Beyond the cr... ey bt Solar wind E
Trees
(@ Cave art Kachi, T.: Takah.. 1997  Dynamic ana versatiie SIructures or aarenal meauta, reiate

49



Moving references into groups (2)

Method 2:
Select references from your library,
Add References To.

right click and select

@ Sync Status

All References

(£ All References 469
& Duplicate References 62
@ imported References 1 ° @ Author Year Title Journal
A Recently Added
: ® De Thabrew, W.... 2014 A manual of water plants
& Unfiled ualolwater p
W/ Trash . P ool ;
@ Del Guerra, A.;... 1996 New Reference ggN 1determinationof alo...  Medical imaging conference
v MY GROUPS Edit References #E
® Goh, K. L.; Liew,... 1996 Copy References To » natic Errors in Dual Ene... Medical imaging conference
Vv Test Copy Formatted Reference #K
@ Anna Karenin... ® Hebber, E.; Olde... 1996 rs in SPECT Tomography Medical imaging conference
e Move References to Trash #D
(@) Assessing im...
(@ Beyond the cr... ® Huang, C.C.; Yu.. 1996 Add References To > Create Custom Group... 2
@ Caveart ® Kachi, T; Takah... 1997 , - el
@ pLT Cut Assessing impact of information skills teaching
Copy Cave art
(® Roald Dahl ° Ma, Y.; Evans, A... 1996 LT 2
(@ Shakespeare - Roald Dahl
@ Solar wind ) Menard, L.; Mas... 1996 Find Full Text Shakespeare 3
@ T Solar wind
ross ® Mirsky, R.; Jesse... 1997 Find Reference Updates Trees el
@ Zhou test fori...
© Motomura, N.; Ic... 1996 OpenURL Link jation Method in Simult... Medical imaging conference
Vv FIND FULL TEXT S i
Vv GROUPS SHARED BY... ® Narita, Y.; lida, H... 1996 Mark as Read i Noise Properties of T...  Medical imaging conference
Mark as Unread
NVGONLINE SEARCH ® Reutter, B. W.; KI... 1996 Rating > atory -Gated PET Tran... Medical imaging conference

@ Jisc Library Hub...
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Moving references into
groups (3)

Method 3:

Simply drag and drop!



Have a go!

www.bodlelan.ox.ac.uk/ask/workshops/reference-management-

workshop-handouts
» Groups

» Adding documents and notes
« Editing references
* Duplicates
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Inserting references into
Word




Cite While You Write

 Plug-in: Cite While You Write.

 Available for Word (Windows and
Mac).

« Automatically added to Word upon
Installation of EndNote.

* Appears in ribbon across top of Word.




Adding a citation in Word (1)

Choose EndNote 20 from the ribbon.

Home Insert Draw Design Layout References Mailings Review View Zotero RCM | EndMote 20
|,,| y EN Go to EndMote Style: Harvard - E“' Categorize References v Tools « 0
0\ E’,‘r Edit & Manage Citation(s) E‘ Update Citations and Bibliography m Manuscript Matcher
Insert B2 Edit Ll — . L Instant Formatting is Off v —-— Help
Citation Ly Edit Library Reference|s) B‘ Configure Biblicgraphy =+ Preferences

Choose a citation style from the drop-down
menu. Click Select Another Style to see more
options.

Home Insert Draw Design Layout References Mailings Review View Zotero RCM EndNote 20
|”| _ EN Go to EndNote . Style: Select Another Style... ;;wnze Refarancas v Tools v 0
Q F’,‘» Edit & Manage Citation(s) E=:| Update Citat Annotated 1 g_ﬂ_i} Manuscript Matcher
Insert = : . APA 6th ant Formatting is Off v —-— Help
Citati [ Edit Library Reference(s) = Configure Bil [ —~ Preferences
e T8 | Z Author-Date e
& z — Chicago 17th Footnote |,
v Harvard |
MHRA (Author-Date) fi
Numbered

Show All Fields
Turabian 9th Footnote
Vancouver 55




Adding a citation in Word (2)

*NB. If using a footnote style, you first need to click
References > Insert footnote, then move over to
the EndNote tab in the ribbon to insert the
reference.

Viailings Review V

-ﬁﬂt}rle: Harvard -... -

B, Next Footnote ~ e &, Bibliography Options ~
Insert

Show Notes Citation =

s otnotes M RefWorks Citation Bibliography

Footnote
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Adding a citation in Word (3)

Place your cursor where the citation is to be
inserted and click Insert citation > Insert citation

@ H A

FILE HOME  INSERT  DESIGN
99 €, Go to EndNote Sty
Q B2 Edit & Manage Citation(s) [

Insert
itatinn v Edit Library Reference(s) [

Q nsert Selected Citation(s)

] Insert Note...

2 Insert Figure..,
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Adding a citation in Word (4)

This will open a
dialogue box. Find
the relevant
citation(s) by
submitting a
search, clicking
the relevant
citation(s) and
clicking Insert.

Find Citation: | Ci~ literacy

m] Search: | Libraries a

Author ~ Year
202
Angell 2015
Belanger 202
Blank 2017
Boh Podgornik 2016
British 20Mm
Chartered Instit...
Doyle 1994
Erlinger 2018
Erlinger 2018

Title

Human evolution: hobbit small, but not stunted

Using quantitative research methods to determine t...
Developing a collaborative faculty-librarian informat...
A novel assessment tool for quantitative evaluation...
Development, testing, and validation of an informati...
Information handling in collaborative research : an e...
Information Literacy

Information literacy in an information society : a con...
Outcomes Assessment in Undergraduate Informatio...
Outcomes assessment in undergraduate Information...

Reference Type: Journal Article

Record Number: 295
Year: 2012

Title: Human evolution: hobbit small, but not stunted

Journal: Nature
Volume: 482

Issue: 7384

Pages: 135

ISSN: 0028-0836

DOI: 10.1038/482135a

?

Library: My EndMote Library.enl

SLCI (Insert |-

19 items in list
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Adding a citation in Word (5)

* Alternatively, you can browse your references in
EndNote, return to Word and click Insert
selected citation(s).

@ Sync Status

All References

— -~ P
I | JB@
5 Duplicate Referenc... 62 469 References

# Imported Referenc... 1 ™ @ Author Year Title Journal Last Updated ~ Ref Type
£\ Recently Added 14
- " De Thabrew, W.... 2014 A manual of water plants 08/11/2019 Book
E unfiled 409 J p M/
=
W Trash 5l [ Del Guerra, A.;... 1996  Measurement of absolute light yield and determination of alo...  Medical imaging conference 08/11/2019 Conference PI
v MY GROUPS
® Goh, K.L.; Liew,... 1996  Correction of Energy Dependent Systematic Errors in Dual Ene... Medical imaging conference 08/11/2019 Conference PI
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Adding page numbers to a citation (1)

Click the reference you would like to add page numbers
to, so it is highlighted grey.

“Around 1580, a distinct group of plays—domestic tragedies as they came to be known—
began to appear in the new professional playhouses of London” {Bensnn, 2012)

Click Edit & manage citations.

B HS O A-
FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES
F Style: |Harvard -
Inzi L_' Update Citations and Bibliography
Citation = |._I Convert Citations and Bibliography -
Citations Bibliography




Adding page numbers to a citation (2)

* Add the page number(s) in the Pages box.

IEIEEEN Reference
Format: | Default ﬁ

Prefix:

Suffix:

Pages: 10-1

70 R

Cancel
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Adding page numbers to a citation (3)

* For some citation styles, you may need to add the
page numbers to the suffix field.

- Edit Citation [JLECE
Format: Default H

Prefix:

Pages:

?) (@ cancel | (KT

Totals: 1 Citation Group, 1 Citation, 1 Refereance
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Creating bibliographies in
EndNote




Bibliography (1)

* You may also like to create a reference list of everything
you read in addition to a bibliography of cited items.

* In EndNote, select your citation style under Tools >
Output Styles.

Library BCEISE Window  Help
Install EndNote Click Browser Extension

bte Library.enl

Output Styles > New Style...
Import Filters > Edit "Harvard"
. Connection Files > Open Style Manager... —
Cite While You Write [CWYW] > Annotated
Format Paper > APA 6th
Subject Bibliography... Author-Date
pr Show Connection Status thieado Tith foditate |
v Harvard
habrew,}  Online Search... MHRA (Author-Date)
Numbered

Show All Fields
Turabian 9th Footnote

Vancouver
K.L.; Liew,... 1996 Correction of Energy Dependé ; . wyers

Ko 1996 Measurement of absolute lig

64



Bibliography (2)

» Select the references you would like to copy in EndNote.
Click References > Copy Formatted Reference. Open
Word and paste the references into your document.

BEICICLGEEE Groups  Library  Tools

New Reference #N
Edit Reference #E
Copy References To >
Copy Formatted Reference

Move References to Trash 8D

File Attachments >

PDF Viewer >
Find Full Text > Yel
Find Reference Updates

URL > 2
Figure >

Web of Science > "

Reference Summary 1€

Hebber, E.; Olde...

Huang, C. C.; Yu...

® Kachi, T.; Takah... 19
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Organising your bibliography (1)

* You may like to organise the bibliography
differently, e.g., primary and secondary

resources.

In Word, click
Categorize
References >
Configure
Categories

MAILINGS REVIEW VIEW ZOTERO

Export to EndNote ~ e

E% Categorize References ~

v Group References by Custom Categories

Configure Categories...

atcher

Tools

EndNote X9

Help

l




Organising your bibliography (2)

A pop up box
will appear.
Drag and drop
references into
the ‘Primary’
and ‘Secondary’
headings
already
available.

EndMote X% Configure Categories et
+| Category Headings | Search References v] =i
.
References Author Year Title Reference Type Category
E“ Reti;ereTcE; E I‘;:Sllugra. = [S) Demeter 2011  Pearls in Beauteous Ladies' Eyes...  Journal Article Primary Sources
nca gnrlzed_ eferences  (0) Mansfield 2018 The use of ascospores of the di...  Journal Artide Secondary Sour
Category Headings Mujezin... 2018 Effect of misletoe (Viscum album...  Journal Artide Secondary Sourn
=| Primary Sources (1)
-| Secondary Sources [ied]
£ >
Reference Type:  Journal Article ~
Author: Mansfield, 1. W.
Galambos, M.
Saville, R
Year: 2018
Title: The use of ascospores of the dieback fungus Hymenoscyphus fraxineus for infection
assays reveals a significant period of biotrophic interaction in penetrated ash cells
Journak Flant Pathology
Volume: 67
Issue: -]
Pages: 1354-1361
ISSh: Q0320862 A
Cancel Help
Library: Traveling Library 3 items in list
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Organising your bibliography (3)

Your bibliography will now be organised by category.

The Red and the Black was a fantastic book written by Stendhal !

Primary

Agatonovic-Kustrin, S., E. Kustrin, and D. W. Morton. "Essential Oils and Functional Herbs for Healthy
Aging." Neural Regeneration Research 14, no. 3 (Mar 2015): 441-45,
https://doi.org/10.4103/1673-5374.245467.

Secondary

Beyle, Marie Henri. Vie De Napoléon, Par De Stendhal. 2e éd. ed. Paris, 1877.
Stendhal. "Promenades Dans Rome." In Vie De Napoléon, edited by Marie Henri Beyle. Paris, 1877.
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Saving a copy of your library

itis a good ideato save a | oo e e
copy of your library in case [— §§ SharsaLry. 040

anything happens to your sl cose o W _
Computer_ imported Refere SR L

Recently Added Save a Copy.

Unfiled
| Share... Gue
Trash

Export...

Click File > Save a wvorours [N «
Copy... VTés'tlxnna Ka ::?‘:SL aEP

. ng,
LN Compressed Library (.enlx)... g

(@ Beyond the cr... 31 ~ Kachi, 1

[N
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Keeping EndNote up to date

It is iImportant to keep EndNote up to date.
Fixes for problems are released.

Click Help > Check for Updates

File Edit References Groups Library Tools Window Help

Get Technical Support

EndNote Output Styles
helen.bond@bodleian.ox... Check for Updates...

All References

@ Sync Status EndNote Community
Search Knowledge Base
EndNote Training Portal

[E All References

@l Document1 1 All Reference
& Duplicate Referenc... 60 469 References

EndNote online

Download EndNote Plug-ins

@ Imported References 1
Q Recently Added 15

Activate EndNote

About EndNote 20
=l 1 Infilad ANQ 8972 Giraites




What is Al (Artificial Intelligence)?

% Al tools can generate text, images, sounds etc. based on prompts
a provided by users.

g9  Can also help with other aspects of academic work such as summarising
k6 texts, paraphrasing and locating published research.

@ It is important to acknowledge the use of Al tools by referencing them.

In-text citation
The Al-generated flower (Shutterstock Al, 2023) ...

Reference list

Shutterstock Al (2023) Photo of pond with lotus flower [Digital art]. Available at:
https://www.shutterstock.com/image-generated/photo-pond-lotus-flower-
2252080005 (Accessed: 31 March 2023).



https://www.shutterstock.com/image-generated/photo-pond-lotus-flower-2252080005

EndNote and Al

* EndNote does not currently have any new Al
functions.

* How to reference Al tools or the things they
create?

* Many referencing styles still to offer guidance!
* No specific 'Al' source type in EndNote.

. . Template Template or Resource type for
Integratlotr;:;;t?h FEr or Resource type for referencing Al generated
; referencing Al tools content

 EndNote Click Computer Program ¢ Use closest

e ResearchRabbit matching content type.
e Use ‘Generic’
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Use Help from the EndNote menu or F1

Official EndNote tutorials
http://clarivate.libquides.com/endnote training/home

Local help is available by emailing
reference-management@bodleian.ox.ac.uk
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Questions




Have a go!

www.bodlelan.ox.ac.uk/ask/workshops/reference-management-

workshop-handouts

« ‘Cite While You Write’ Word plugin
* In-text citations
» Footnotes

» Page numbers
 Creating a bibliography
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